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ARTICLE DATE:  04.18.07 

By Jeremy A. Kaplan and PC Magazine Staff  
 
Like driving a new car, adjusting to a new operating system takes time. Discovering new features and 
functions (so that's how you adjust the steering wheel!) helps to shorten the acclimatization period, letting you 
turn a mass-market product into one customized for you. Do you prefer bigger, better-looking icons? Is 
increased security worth a few extra clicks, in your eyes? Would you like to link all your gadgets to the new 
system the right way—the first time? Then we've got the guide for you. We'll walk you through Vista's many 
neat features and more than 50 tips on installing Vista optimally, configuring it for you and your family, 
improving system speed, and turning up its coolness. When we're through, you'll have made the new OS 
uniquely yours. — next: Tips 1 through 6 

1. Command Authority 
Like a scene straight out of Kramer vs. Kramer or Mad Magazine's Spy vs. Spy, Vista has two types of 
administrators. What gives? First, understand that there are two kinds of user accounts, Administrator and 
Standard. This refers to the level of privileges—the things you're allowed to do. In addition, and separately, 
there is an account named Administrator. It's typically used to sort out problems that keep you from logging on 
to your normal account. As in Windows XP, you should rename the Administrator account for security 
purposes (just don't forget what you've changed it to). Right-click Computer and click Manage. Under Local 
Users and Groups, open Users, right-click the one named Administrator, and choose Rename. Then right-click 
it and choose Properties to delete its telltale description as well. 

2. Improve Your Network 
There are two types of wireless networks known to Vista: public and private. Public networks are less secure, 
so the OS disables discovery of other devices when connected to one. But by default, Vista makes your 
network public. Go private instead, enabling a much more comprehensive view of the network behind your 
router using a new protocol called Link Layer Topology Discovery. In the Network and Sharing Center, click 
Customize under the picture of your network at top. Switch to Private and click Next. While you're optimizing 
things, note the various sharing options listed; it's easy to give all of your PCs access to your printer here. 

3. Truly Secure Your Files 
Password-protecting your laptop is good overall security, but for added protection, 
start encrypting. Vista Enterprise and Ultimate editions come with BitLocker Drive 
Encryption, a tool that relies on a Trusted Platform Module to secure access—check 
your manual to see if your notebook has one and update your BIOS if needed. To 
make the magic happen, you'll need an extra partition on your hard drive that you can 
create with the Vista partitioning tool on your installation disc or with the BitLocker 
Drive Preparation Tool, a Vista Ultimate Extra. You'll create one small partition for 
essential OS files, and the rest of the drive will hold encrypted files. Format the 
partition as NTFS, not FAT32. 

4. Run Two Operating Systems 
Apple's Boot Camp software lets you run the Microsoft Windows XP operating system 
on an Intel-based Macintosh, but it doesn't support Vista—and it's still in beta, almost 

a year after its release. To run Microsoft's newest OS on your Apple, get Parallels Desktop for Mac. This 
virtualization software lets you run two operating systems simultaneously by taking advantage of the Intel Core 
Duo's built-in virtualization technology. To get Vista running smoothly in a window on your OS X desktop, be 
sure to boost the program's memory requirements to 2GB; Vista won't run well with only 1GB of memory for 
the subsystem. 
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5. Beautify Your Boot 
The boot screen built into Windows is functionally useless. Why not make it look prettier? Microsoft designed a 
built-in boot screen that replaces the animated start-up bar (you'll see it if you awaken your PC from 
hibernation); it provides just as little information, but it looks a whole lot better. To enable it, run MSConfig from 
the Start menu, and under the Boot tab, select No GUI Boot. 

6. Be a Mobile Power User 
Windows Mobile devices are handy, but are crippled off the bat. The new operating system comes with a Sync 
Center that lets you sync only media files, not your PIM info. Before plugging your device in for the first time, 
go to the Download Center at Microsoft.com and search the Mobile Devices category for the Windows Mobile 
Device Center, which powers up support for syncing e-mail, calendar data, and contact info. Once you've used 
the Device Center to transfer your calendar to your handheld, right-click it in My Computer to see the gadget's 
charge state, and you'll always be fully powered.  

7. Find Your Router 
To add encryption to your network, boost the speed, control access, and manipulate your bits in other ways, 
you'll probably need to log on to your wireless router, often via a built-in Web page served from the device. 
This Web page is usually given a difficult-to-remember IP address, such as 192.168.2.1. Find your router's 
home page easily via the Network and Sharing Center; first click View full map at top right, then right-click your 
router or wireless access device and select Go to Device Home Page. 

8. Enable Concurrent Sessions 
Server versions of Windows let multiple users log on to a PC simultaneously; this is handy for home-theater 
enthusiasts who want to perform remote maintenance on a system that others might be using to watch TV, for 
example. To get this working under Vista Business or Ultimate editions, you'll need to replace the Termsrv.dll 
file with a hacked version. You can find the complete instructions and a link to the new DLL at the Missing 
Remote Web site, www.missingremote.com. 

9. Be The Boss 
In order to limit the havoc that rogue programs can cause, administrator accounts aren't totally in charge. To 
gain complete control (to install antispyware, for example), log on as the Administrator—but not all the time, or 
you'll negate this account's raison d'être. The Administrator account won't show up in the User Accounts 
control panel, however: It's disabled by default. In Vista Ultimate or Business editions, right-click it in the 
Management Console (as described in the first tip) and select Properties. Uncheck Account is disabled and it'll 
show up in the control panel. That's the super-mega-ultimate account. Don't have Ultimate? Click Start, type 
cmd, right-click the cmd.exe item at top, and choose Run as administrator. Type net user 
administrator /active:yes and log off. The Administrator account now shows up on the welcome screen. 

10. Install From an Upgrade Disc 
Past Windows versions have let you prove upgrade-readiness by inserting a CD of the previous OS during the 
install process. Vista doesn't; Microsoft specifically says "Windows Vista does not check upgrade compliance. 
Therefore, you cannot use an upgrade disc to perform a clean installation of Windows Vista." To work around 
this problem, insert your CD into your clean computer. Don't enter the code when Vista asks for your license 
key, simply click Next. You'll create a system sans activation code that's active for 30 days. Then reboot from 
the CD; you'll be able to install the OS as an update to your Vista installation. Now use the activation code. — 
next: Tips 11 through 20 

11. Save Your Music! 
We've all been buying audio and video files wrapped in DRMs from Microsoft, Apple, and others. What 
happens to that content when you upgrade to Vista? If you've bought digital media from stores running 
Windows Media Player 10, you'll be asked to reauthorize the content. With stuff from Apple's iTunes, 
deauthorize your PC before upgrading to Vista. Simply sign in to the iTunes store, and, from the Store menu, 
select Deauthorize Computer. After upgrading, reverse the process to re-enable access to your files. If you've 
authorized the maximum five PCs, select View My Account from that same menu, where you can "Clear all 
authorizations" once a year. 

12. Extend Activation 
Are you testing out Vista's features and compatibility but not sure if you want to go ahead and activate it? 
Microsoft understands. It has built a software licensing manager into the new OS that lets you extend the 
activation period. At the Start menu's search bar, simply type slmgr -rearm to get another 30 days. You can do 
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this a maximum of three times before Microsoft blocks further extension periods. And once you're locked out, 
that's it. 

13. Prevent Vertigo on Vista 
The new 3D desktop is a tremendous improvement, but not all of the features are handy, and some of the 
settings are downright disconcerting. Control your own 3D experience! First, right-click Computer and choose 
Properties to get the System Properties page. Click Advanced system settings. On the Advanced tab, click 
Settings in the Performance section. The Visual Effects field is where you can choose to Adjust for best 
appearance, Adjust for best performance, Let Windows choose, or go wild with your own choices. 

14. Snip at Will 
Power users are comfortable using the PrintScr key to capture screen shots, but there's a better way in Vista. 
You can use the integrated Snipping Tool to capture any object on your screen and then annotate, save, or 
share the image. Simply use the mouse to capture free-form shapes, rectangles, whole windows, or full 
screens. After you capture a snip, it's automatically copied to the markup window, where you can annotate, 
save, or share it. Bonus: If you've clipped from an Internet Explorer window (not Firefox or Opera) and save 
the snip as an HTML file, the URL is automatically appended to your image. Neat! 

15. Play Six Degrees of Kevin Bacon 
Love him or hate him, Kevin Bacon is a name you'll never forget. Now you can play "find the actor" anytime 
(not officially, that is, but bear with us) using Windows Vista. First, launch Windows Media Center from the 
Start menu. Navigate to TV + Movies and select Recorded TV. Select the movie you are interested in (Vista 
comes with snippets from Apollo 13 and Vertigo, just to get you started). Select Cast + More, pick a cast 
member, and repeat until you find Mr. Bacon. 

16. Work With The SideShow 
Vista supports a secondary display (ideally on your laptop's lid, as on the cool Asus W5FE) for you to get quick 
access to e-mail, photos, calendar info, and music files. And that's just scratching the surface. SideShow info 
can be stored and accessed in two ways: either from the hard drive, which takes longer and involves caching, 
or directly from a flash component in your system—quicker, but space is limited. The flash component shows 
up as a separate drive in Windows Vista that you can drag and drop MP3s and photos to. Some gadgets 
require use of the hard drive; you won't be able to access them if the system is off. Instead, put it to sleep, and 
set Vista to wake every 5 minutes, updating e-mail, calendar, and other gadgets that rely on an Internet 
connection. 

17. Pick Your Feeds 
The Sidebar's RSS Feed Reader is handy, but by default it picks up feeds only directly from Microsoft. Making 
it work for you is a two-stage process. First, find a Web page with an RSS feed on it using Internet Explorer—
the orange feed icon at the right of the status bar lights up to indicate the feed's presence. Click it, and select 
Subscribe to this feed. Then right-click on the module and select Options; you'll be able to choose which feeds 
and how many items are displayed. Want to find feeds using Firefox instead? Download the Common Feed 
List tool from www.netcrucible.com/blog. 

18. Be a Better Parent 
Kids need structure, otherwise they'll spend hours browsing the Web for dirty limericks. Turn to Vista's parental 
controls for a quick and easy way to monitor how long they're online—and who goes where. First, create an 
account for each child in the User Accounts control panel. Then click Set Up Parental Controls to create and 
set limits. Don't forget to enable activity monitoring as well. It's okay—you're Dad, not Big Brother. You can 
view them later by visiting the same section of the control panel. But be forewarned: Parental controls are 
available only to PCs on a workgroup, not those on a domain. 

19. Reduce Power Consumption 
As laptops became more popular, consumers became aware of Win XP's power settings. Standby left your 
computer running at low power; hibernate saved all memory to disk and then shut down your system—but 
often balked at problem programs. With Vista, Microsoft redrew the rules, adding an "away mode" and 
defaulting to "sleep" rather than off. Sleep mode starts off like standby but saves memory like hibernate. Then 
after 15 minutes it just shuts off, with no back talk from programs. Nicely done, Microsoft! To shut down 
completely, skip the Start menu's orange power button in favor of the right arrow next to it. 

20. Get help 
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The Help and Support Center built into Windows XP was a good start but far from ideal. Though it appears 
similar to Win XP's, Vista's Support Center is much improved. Besides the usual documentation on core OS 
functionality, Vista's integrated system can get the latest help info from the Web, allow a friend to help by 
remote assistance, or search in "Windows communities." Type a word or phrase into the main search field and 
hit enter. At the bottom of your returned results is a useful link to these other sources of assistance. — next: 
Tips 21 through 30 

21. Boost Your System Speed 
Hybrid hard drives, which embed a cache of flash memory inside a hard drive's 3.5-inch shell to improve its 
performance, aren't on the market yet. But they're just one way Vista uses flash memory; ordinary thumb 
drives can, cheaply and easily, let your PC read small, random bits of frequently accessed data, a Vista 
feature called ReadyBoost. Here's the thing: To maximize its efficiency, a ReadyBoost thumb drive should 
have the same amount of memory as is built into your system. In other words, match your 2GB of RAM with a 
2GB flash drive for best performance. 

22. Uncover Send To 
The Send To menu is a handy way to quickly move files into frequently accessed locations. The default 
locations are Microsoft's favorites, however, and they might not be yours. In Windows XP it was possible to 
add to the Send To menu by putting a shortcut in the SendTo folder. But try that trick with the SendTo folder in 
your Personal folder and you'll be hit with an "access denied" message. That's because it's just a pointer to the 
real one, which you will find at C:\Users\username\AppData\Roaming\Microsoft\Windows\SendTo. You can 
add shortcuts to that one. 

23. Launch Apps Faster 
When you place items in the Quick Launch bar (the little icon bar next to the Start button), Windows Vista 
automatically assigns shortcut key combinations to them—well, it assigns keys to the first ten, anyway. Just hit 
the Windows key plus a number key corresponding to the icon's position in the bar. For instance, to launch the 
third application in the Quick Launch bar, press Windows-3. Don't see the bar? Right-click an empty part of the 
Taskbar and select it under the Toolbars menu. 

24. Add 3D Sound 
If you're having trouble getting full 3D sound in Windows XP games from your SoundBlaster sound card, use 
Creative's ALchemy tool. Windows Vista uses an audio API called OpenAL for its game audio, and some 
DirectSound games won't use anything beyond two stereo speakers, ignoring EAX and other APIs. Download 
the Creative ALchemy beta from preview.creativelabs.com/alchemy, install it, and run it. The ALchemy tool will 
cause Windows XP games that lack OpenAL support to pipe their DirectSound calls through OpenAL, giving 
you full 3D audio support. 

25. Restore Your Menus 
Vista's own windows and many new applications lack the familiar File, Edit, and View menus. But we've gotten 
used to them after all these years! You can enable them through each application—if they're included at all. To 
turn them on in Vista proper, open any window (such as Computer, or Documents), click Organize, and click 
Folder and Search Options. Select the View tab and fill in the check box next to Always Show Menus. Click 
Apply and then OK. Alternatively, to show the menus temporarily, just hit the Alt key with any given window in 
the foreground. 

26. Eliminate That Warning 
Windows Vista hates it when you don't use an antivirus program, a firewall, or some other security feature. But 
if you don't need one part of the built-in security, you also don't need the Security Center shield icon to pop up 
constantly in the system tray. Right-click the icon and click Open Security Center. Then, in Security Center, 
click Change the Way Security Center Alerts Me. You want to select Don't Notify Me and Don't Display the 
Icon (even though Windows tells you it's "Not Recommended"). 

27. Add Photos Faster 
Most digital cameras come with proprietary software for importing pictures into Windows and cleaning off the 
camera's memory card, generally a two-stage process. You can do it all in one step with Windows Photo 
Gallery, which has an auto-erase feature. It lets you dump photos and erase your camera's memory card with 
one click, preserving a bit of battery life and simplifying yours. Select Options from the File menu, and under 
the Import tab, select Always erase from camera after importing. Good? Maybe. Potentially dangerous? 
Definitely. Proceed with caution. 
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28. Get The Power Prompt 
The Command Prompt, though buried in the Start menu, is an enduringly versatile application. Too bad it's 
hampered by User Account Control, which will prevent certain apps from running properly because of a lack of 
permissions. To upgrade its capabilities, navigate to the Accessories folder in the Start menu, right-click on 
Command Prompt, and select Run as Administrator. If you find yourself doing this frequently, try this shortcut: 
The search box in Vista's Start menu can serve the same function. Simply enter a command, hold the Shift 
and Ctrl keys, and press Enter. 

29. Be An Icon Artist 
You may have noticed that by simply holding down the Ctrl key you can use your mouse's scroll wheel to 
resize a folder's icon. But you may not have noticed that this works on the desktop itself. You can resize from 
standard 48-by-48-pixel icons to full 256-by-256 photo quality renditions. Power users: Go to Computer and 
click the arrow to the right of the View menu, where you'll find a slider with an endless selection of icon sizes. 

30. Know Your Velocity 
Everyone knows about the Windows Experience score, but a power user won't find the information there as 
comprehensive or useful as one could wish. Skip it in favor of Microsoft's Management Console. Right-click on 
Computer and select Manage. Then select Reliability and Performance and take a look at your system's 
Reliability Monitor in the collection of monitoring tools. This system stability index gives a weighted value of 
how stable your PC is based on data collected over its lifetime. Little red X's show where specific failures 
occurred. It's a great troubleshooting tool. — next: Tips 31 through 40 

 
31. Create an XPS Document 
XPS (which stands for XML Paper Specification) can be very useful; it's effectively an open-standard version 
of the popular-but proprietary Adobe Acrobat format. What does it all mean? You can create, edit, print, and 
save the documents without paying Adobe for a license. To create an XPS document, create a file in any word 
processor (Notepad, WordPad, Word, and so on) and click Print . . . . Then select the automatically installed 
XPS Printer to "print" the document to an XPS file. 

32. Sync Everything! 
Need to sync to something that's not supported? Say, to a digital camera, across folders, or even between 
different computers? SyncToy 1.4, a PowerToy from Microsoft, now supports Windows Vista and will let you 
sync a folder to a removable hard drive, a network share, and other things. You can pick up the tool for free 
from Microsoft's Download Center. 

33. Set Affinity 
Multitasking is an efficient way to spread resources across multiple CPUs—or the multiple cores of a dual-core 
CPU (or quad-, or octo-, or whatever!). But if you have a single application that consumes a large amount of 
the system's resources, such as Norton AntiVirus, bypass the multitasking and set it to run exclusively off a 
single core, potentially improving its efficiency. Bring up the Task Manager, find the resource-hogging process 
(for Norton, it's called nprotect.exe), right-click it, and select Set Affinity. Then deselect one of the cores, 
isolating the process and boosting its efficiency. 

34. Move Your Stuff 
Personal folders are handy, but they may not live where you want them to. Fortunately, you can relocate your 
own folders fairly easily. Click your username at the top right of the Start menu to open your profile. Right-click 
Documents and choose Properties. Then click Location | Move and select the new location, or even create it at 
this time. You'll be asked if you want to move your documents; hit Yes, of course. Don't try this with the Public 
folder, though: There's a Location tab, but no Move button. 

35. Know your Autoplay 
XP's Autoplay functionality was merely a thing the OS did, but Vista makes it useful with a control panel applet 
(including Blu-ray and HD DVD support!). Type Programs in the Start menu and hit Enter and you've got 
complete control. 

36. Create zipped files (again) 
Vista opens password-protected ZIP files, but it no longer creates them (Microsoft says passwords don't afford 
serious security). Your best bet: Download SecureZIP. It's a stable—and free!—alternative. 
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37. Restore your files 
In XP, System Restore fixes OS problems but won't do squat if you accidentally save a file rather than quitting. 
In Vista, it creates "shadow copies" of your files daily; just right-click a Word, Notepad, or Wordpad file to roll it 
back to earlier versions. 

38. Improve Windows Sidebar 
Though the Sidebar is handy, an overcrowded Sidebar merely adds desktop clutter. For gadgets that don't 
provide "glanceable" data, right-click the gadget and set opacity to 40 percent. It'll fade out when not in use. 

39. Go International 
Need to know the time in Lima? Or Monaco? Searching for time zones in the control panel will reveal an option 
to add clocks for different time zones. 

40. Gain Speed 
Does Vista seem slower than XP to you? A default power setting in the "Power Saver" plan limits the CPU to 
50 percent. Open the Power Options control panel and change it to "High Performance" to give it full throttle. 
— next: Tips 41 Through 50 

41. Search Elsewhere 
Internet Explorer's default search engine is MSN.com. Boo! Click the drop-down menu next to IE's magnifying-
glass icon and select "Find More Providers…" Adding Amazon, eBay, and MTV make searching much more 
fun. 

42. Launch Apps Faster 
Want to find that program? Don't search through all those menus on the Start button, just type the first couple 
of characters into the bar at the bottom and the name will appear. 

43. Keep Personal Data Private 
You can add titles, ratings, and more to songs and photos. But you want to share files, not your personal 
notes. Right-click a file, choose Properties, click the Details tab, and click the link at the bottom to "Remove 
Protection and Personal Information." 

44. Search By Voice 
Enable the built-in natural language search feature; it's on the Search tab in the Folder Options control panel. 
Now you can type, say, files created last month or music by Tom Lehrer. 

45. Take a Meeting 
Vista has a calendar that lets you share your schedule with others online. Type Calendar into the Start menu 
to launch it. Add a few appointments and click the Share menu and you're off!  

46. Send Faxes 
You may have a cable modem, but the odds are good that your PC has an integrated fax modem, too. Take 
advantage of it with Vista's built-in fax-center software. 

47. Improve Compatibility 
Stuck with an old program you love that just won't run in Vista? Search Help and Support for compatibility 
mode, and start the wizard to get that program going in the new OS. 

48. Get a Digital Keyboard 
Windows Vista comes with a virtual keyboard, handy if your real one breaks. Simply punch OSK into the Start 
menu's Search field and hit enter to bring up the on-screen keyboard and use your mouse to "key" in data. 

49. Hire a Robot Secretary 
Get CDYNE Corp.'s Phone Notify sidebar gadget from Microsoft's gadget gallery. Then type a sentence and a 
phone number into its sidebar field and the tool will instantly translate your text into speech and place the call. 
Cool! 

50. Get Animated 
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Vista Ultimate users are privy to an Extra called DreamScene, which adds video desktop wallpapers. Buy 
Stardock's DESKScapes instead, which lets you set computer-generated animations as wallpapers too. 

The Other Next-Gen OS: Apple's Leopard Looms over Vista 
ARTICLE DATE:  04.18.07 

By Nick dePlume  

By the time you read this, Apple may have announced a ship date for Leopard, the company's new operating 
system formally labeled Mac OS X 10.5. Or not. The super-secretive firm offered users a first glimpse of 
Leopard, more than two years in development, in August 2006 and has said only that it will ship in spring 
2007. 

Unlike Microsoft, which releases beta versions of Windows to millions of testers, Apple keeps its cards close to 
the vest, sending new OS builds only to trusted developers roughly once every 45 days. Based on public 
information and months of testing by sources, it's apparent that Apple faces the same challenge it encountered 
with the release of Tiger (Mac OS X 10.4) two years ago: improving on an already highly regarded OS. 

Apple bills the new Time Machine feature as a major improvement over other approaches to backing up your 
data because of its seamless integration and slick interface. Once you've initially backed up, you specify how 
often Time Machine should troll for changes. If you need something you deleted a week ago or a draft of a 
document from a month ago, Leopard can "go back in time" and browse your hard drive as it was back then, 
retrieving the desired file. 

Time Machine's comprehensive approach to backup is also its biggest flaw, however, requiring substantial 
hard drive space. Casual users with modest media libraries will encounter few difficulties, but those with 
meatier collections will either need to invest in additional hard drives or instruct Time Machine to ignore 
particular folders, leaving them without backups. 

Spaces is another compelling new feature, letting you operate several desktop environments simultaneously. 
Instead of running applications side by side, you can instead run photo-related applications in one Space while 
placing e-mail and Web browsing software in another. A simple key command switches Spaces, akin to 
switching between applications. This way you don't have to minimize what you're working on when you receive 
notification of a new e-mail—or juggle business and personal tasks in the same screen. 

The biggest improvements in Leopard are those consumers won't see, at least not directly. Among the most 
notable: Core Animation, which lets developers add slick animations to their software without taxing system 
resources. 

— Nick DePlume and the Think Secret staff, who cover Apple, the Macintosh, and related software with a mix 
of news and other inside info at www.thinksecret.com 
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